Debugger Application (DEBUGGER)

version 2.3
Typeset in \LaTeX{} from SGML source using the DOCBUILDER 3.3.2 Document System.
Contents

1 Debugger User's Guide 1
  1.1 Debugger .................................................. 1
      1.1.1 Introduction ...................................... 1
      1.1.2 Getting Started with Debugger .................... 1
      1.1.3 Breakpoints ........................................ 2
      1.1.4 The Monitor Window ................................ 5
      1.1.5 The Interpret Dialog Window ....................... 9
      1.1.6 The Attach Process Window ......................... 11
      1.1.7 The View Module Window ........................... 14
      1.1.8 Miscellaneous ...................................... 16
      1.1.9 Debugging Remote Nodes ............................ 16

2 Debugger Reference Manual 17
  2.1 debugger ................................................ 21
  2.2 i .......................................................... 22
  2.3 int ....................................................... 28

List of Figures 35
Chapter 1

Debugger User's Guide

Debugger is a graphical tool which can be used for debugging and testing of Erlang programs. For example, breakpoints can be set, code can be single stepped and variable values can be displayed and changed.

1.1 Debugger

1.1.1 Introduction

Debugger is a graphical tool which can be used for debugging and testing of Erlang programs. For example, breakpoints can be set, code can be single stepped and variable values can be displayed and changed.

Warning: Note that the debugger at some point might start tracing on the processes which execute the interpreted code. This means that a conflict will occur if tracing by other means is started on any of these processes.

1.1.2 Getting Started with Debugger

Start Debugger by calling `debugger:start()`. It will start the monitor window [page 5] showing information about all debugged processes.

Initially there are normally no debugged processes. First, it must be specified which modules should be debugged, or interpreted as it is also called. This is done by choosing Module→Interpret... in the monitor window and then selecting the appropriate modules from the interpret dialog window [page 9].

Note:
Only modules compiled with the option `debug_info` set can be interpreted. Non-interpretable modules are shown within parenthesis in the interpret dialog window.

When a module is interpreted, it can be viewed in a view module window [page 14]. This is done by selecting the module from the Module→module→View menu. The contents of the source file is shown and it is possible to set breakpoints [page 2].
Now the program that should be debugged can be started. This is done the normal way from the Erlang shell. All processes executing code in interpreted modules will be displayed in the monitor window. It is possible to attach to any of these processes, by selecting the process and then choosing Process->Attach.

Attaching to a process will result in a attach process window [page 11] being opened for this process. From the attach process window, it is possible to control the process execution, inspect variable values, set breakpoints etc.

1.1.3 Breakpoints

Once the appropriate modules are interpreted, breakpoints can be set at relevant locations in the source code. Breakpoints are specified on a line basis. When a process reaches a breakpoint, it stops and waits for commands (step, skip, continue, ...) from the user.

**Note:**
When a process reaches a breakpoint, only that process is stopped. Other processes are not affected.

Breakpoints are created and deleted using the Break menu of the monitor window, view module window and attach process window.

Executable Lines

To have effect, a breakpoint must be set at an executable line, which is a line of code containing an executable expression such as a matching or a function call. A blank line or a line containing a comment, function head or pattern in a case- or receive statement is not executable.

In the example below, lines number 2, 4, 6, 8 and 11 are executable lines:

```erlang
1: is_loaded(Module,Compiled) ->
2: case get_file(Module,Compiled) of
3:   {ok,File} ->
4:     case code:which(Module) of
5:       ?TAG ->
6:         {loaded,File};
7:         _ ->
8:         unloaded
9:       end;
10: false ->
11: false
12: end.
```
1.1: Debugger

Status and Trigger Action

A breakpoint can be either active or inactive. Inactive breakpoints are ignored.

Each breakpoint has a trigger action which specifies what should happen when a process has reached it (and stopped):

- **enable** Breakpoint should remain active (default).
- **disable** Breakpoint should be made inactive.
- **delete** Breakpoint should be deleted.

Line Breakpoints

A line breakpoint is created at a certain line in a module.

Figure 1.1: The Line Break Dialog Window.

Conditional Breakpoints

A conditional breakpoint is created at a certain line in the module, but a process reaching the breakpoint will stop only if a given condition is true.

The condition is specified by the user as a module name `Module` and a function name `Function`. When a process reaches the breakpoint, `Module:Function(Bindings)` will be evaluated. If and only if this function call returns `true`, the process will stop. If the function call returns `false`, the breakpoint will be silently ignored.

`Bindings` is a list of variable bindings. Use the function `int:get_binding(Variable, Bindings)` to retrieve the value of `Variable` (given as an atom). The function returns `unbound` or `{value, Value}`.
Example: A conditional breakpoint calling c_test:c_break/1 is added at line 8 in the module fac. Each time the breakpoint is reached, the function is called, and when \( N \) is equal to 3 it returns true, and the process stops.

Extract from fac.erl:

4. fac(0) ->
5. 1;
6.
7. fac(N) ->
8. \( N \times \text{fac}(N - 1) \).

Definition of c_test:c_break/1:

-module(c_test).
-export([c_break/1]).

c_break(Bindings) ->
case int:get_binding('N', Bindings) of
    {value, 3} ->
        true;
    _ ->
        false
end.
Function Breakpoints

A function breakpoint is a set of line breakpoints, one at the first line of each clause in the given function.

![Function Break Dialog Window](image)

Figure 1.3: The Function Break Dialog Window.

1.1.4 The Monitor Window

The monitor window is the main window of Debugger and shows information about all debugged processes, that is all processes executing code in interpreted modules.
### Chapter 1: Debugger User’s Guide

**Figure 1.4: The Monitor Window.**

<table>
<thead>
<tr>
<th>Pid</th>
<th>Initial Call</th>
<th>Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>⟨0.26.0⟩</td>
<td>ms:start/1</td>
<td></td>
<td>idle</td>
</tr>
<tr>
<td>⟨0.41.0⟩</td>
<td>ms:master_init/1</td>
<td></td>
<td>waiting</td>
</tr>
<tr>
<td>⟨0.44.0⟩</td>
<td>ms:slave_init/1</td>
<td></td>
<td>break</td>
</tr>
<tr>
<td>⟨0.45.0⟩</td>
<td>ms:slave_init/1</td>
<td></td>
<td>waiting</td>
</tr>
<tr>
<td>⟨0.21.0⟩</td>
<td>ms:module_info/0</td>
<td></td>
<td>idle</td>
</tr>
</tbody>
</table>

**Pid**  The process identifier.

**Initial Call**  The first call to an interpreted function by this process. *(Module:Function/Arity)*

**Name**  The registered name, if any.

**Status**  The current status, one of the following:

- **idle**  The interpreted function call has returned a value, and the process is no longer executing interpreted code.
- **running**  The process is running.
- **waiting**  The process is waiting in a receive statement.
- **break**  The process is stopped at a breakpoint.
- **exit**  The process has terminated.
There is no connection to the node where the process is located.

Information Additional information, if any. If the process is stopped at a breakpoint, the field contains information about the location \{Module,Line\}. If the process has terminated, the field contains the exit reason.

The File Menu

Load Settings... Try to load and restore Debugger settings from a file previously saved using Save Settings..., see below. Any errors are silently ignored.

Save Settings... Save Debugger settings to a file. The settings include the set of interpreted files, breakpoints, and the selected options. The settings can be restored in a later Debugger session using Load Settings..., see above. Any errors are silently ignored.

Exit Stop Debugger.

The Edit Menu

Clear Remove information about all terminated processes from the window.

Kill All Terminate all processes listed in the window using \texttt{exit(Pid,kill)}.

The Module Menu

Interpret... Open the interpret dialog window [page 9] where new modules to be interpreted can be specified.

Delete All Stop interpreting all modules. Processes executing in interpreted modules will terminate.

For each interpreted module, a corresponding entry is added to the Module menu, with the following submenu:

Delete Stop interpreting the selected module. Processes executing in this module will terminate.

View Open a view module window [page 14] showing the contents of the selected module.

The Process Menu

The following menu items apply to the currently selected process, provided it is stopped at a breakpoint. See the chapter about the attach process window [page 11] for more information.

Step

Next

Continue

Finish

The following menu items apply to the currently selected process.

Attach Attach to the process and open a attach process window [page 11].

Kill Terminate the process using \texttt{exit(Pid,kill)}.
The Break Menu

The items in this menu are used to create and delete breakpoints. See the Breakpoints [page 2] chapter for more information.

**Line Break**... Set a line breakpoint.

**Conditional Break**... Set a conditional breakpoint.

**Function Break**... Set a function breakpoint.

**Delete All** Remove all breakpoints.

For each breakpoint, a corresponding entry is added to the Break menu, from which it is possible to disable/enable or delete the breakpoint, and to change its trigger action.

The Options Menu

**Trace Window** Set which areas should be visible in the attach process window [page 11]. Does not affect already existing windows.

**Auto Attach** Set at which events a debugged process should be automatically attached to. Also affects existing processes.

- **First Call** - the first time a process calls a function in an interpreted module.
- **On Exit** - at process termination.
- **On Break** - when a process reaches a breakpoint.

**Stack Trace Stack On, Tail** Save call frames in the stack during evaluation.

- **Stack On, No Tail** Save call frames during evaluation, except for tail recursive calls.
  
  This option consumes less memory than the previous option and may be necessary to use for processes with long lifetimes and many tail recursive calls.

**Stack Off** Do not save call frames.

Does not affect already existing processes.

**Back Trace Size**... Set how many call frames should be fetched when inspecting the back trace (from the attach process window). Does not affect already existing windows.

The Windows Menu

Contains a menu item for each open Debugger window. Selecting one of the items will raise the corresponding window.

The Help Menu

**Help** View the Debugger documentation. Currently this function requires Netscape to be up and running.
The interpret dialog module is used for selecting which modules to interpret. Initially, the window shows the modules (erl files) and subdirectories of the current working directory.

Interpretable modules are modules for which a BEAM file, compiled with the option `debug_info set`, can be found in the same directory as the source code, or in an `ebin` directory next to it. Modules, for which the above requirements are not fulfilled, are not interpretable and are therefore displayed within parentheses.

The `debug_info` option causes debug information or abstract code to be added to the BEAM file. This will increase the size of the file, and also makes it possible to reconstruct the source code. It is therefore recommended not to include debug information in code aimed for target systems.

An example of how to compile code with debug information using `erlc`:

```bash
% erlc +debug_info module.erl
```

An example of how to compile code with debug information from the Erlang shell:

```bash
4> c(module, debug_info).
```

1.1.5 The Interpret Dialog Window
Figure 1.5: The Interpret Dialog Window.

Browse the file hierarchy and interpret the appropriate modules by selecting a module name and pressing Choose (or carriage return), or by double clicking the module name. Interpreted modules are displayed with a * in front of the name.

Pressing All will interpret all displayed modules in the chosen directory.

Pressing Done will close the window.

**Note:**
In a distributed environment modules added (or deleted) for interpretation will be added (or deleted) on all known Erlang nodes.
1.1.6 The Attach Process Window

From an attach process window the user can interact with a debugged process. One window is opened for each process that has been attached to. Note that when attaching to a process, its execution is automatically stopped.
Figure 1.6: The Attach Process Window.
The window is divided into five parts:

- The code area, showing the code being executed. The code is indented and each line is prefixed with its line number. If the process execution is stopped, the current line is marked with \(\rightarrow\). An existing break point at a line is marked with \(-\). In the example above, the execution has been stopped at line 56, before the execution of \texttt{io:format/2}.
  
  Active breakpoints are shown in red, while inactive breakpoints are shown in blue.

- The button area, with buttons for quick access to frequently used functions in the Process menu.

- The evaluator area, where the user can evaluate functions within the context of the debugged process, provided that process execution has been stopped.

- The bindings area, showing all variables bindings. Clicking on a variable name will result in the value being displayed in the evaluator area. Double-clicking on a variable name will open a window where the variable value may be edited. Note however that pid, reference, binary or port values can not be edited.

- The trace area, showing a trace output for the process.

\[ ++(N) \langle L \rangle \] Function call, where \(N\) is the level of recursion and \(L\) the line number.

\[ --(N) \] Function return value. Note: Return values of calls with last call optimization are not traced.

\[ == \text{Pid} : \text{Msg} \] The message \(\text{Msg}\) is sent to process \(\text{Pid}\).

\[ <= \text{Msg} \] The message \(\text{Msg}\) is received.

\[ ++(N) \text{receive Waiting in a receive.} \]

\[ ++(N) \text{receive with timeout Waiting in a receive...after.} \]

Also the back trace, i.e. a summary of the call frames in the stack, is displayed in the trace area.

It is configurable using the Options menu which areas should be shown or hidden. By default, all areas except the trace area is shown.

The File Menu

\textbf{Close} Close this window and detach from the process.

The Edit Menu

\textbf{Go to line...} Go to a specified line number.

\textbf{Search...} Search for a specified string.

The Process Menu

\textbf{Step} Execute the current line of code, stepping into any function calls.

\textbf{Next} Execute the current line of code and stop at the next line.

\textbf{Continue} Continue the execution.

\textbf{Finish} Continue the execution until the current function returns.

\textbf{Skip} Skip the current line of code and stop at the next line. If used on the last line in a function body, the function will return \textit{skipped}.

\textbf{Time Out} Simulate a timeout when executing a \texttt{receive...after} statement.

\textbf{Stop} Stop the execution of a running process.
Where Make sure the current location of the execution is visible in the code area.
Kill Terminate the process using `exit(Pid,kill)`.
Messages Inspect the message queue of the process. The queue is printed in the evaluator area.
Back Trace Display the back trace of the process, i.e. a summary of the call frames on the stack, in the trace area. Requires that the trace area is visible and that the stack trace option is set to 'Stack On, Tail' or 'Stack On, No Tail'.
Up Inspect the previous call frame. The code area will show the location and the bindings area will show the bindings for that call frame.
Down Inspect the next call frame. The code area will show the location and the bindings area will show the bindings for that call frame.

The Options Menu

Trace Window Set which areas should be visible. Does not affect other attach process windows.
Stack Trace Same as in the monitor window [page 5], but does only affect the debugged process the window is attached to.
Back Trace Size... Set how many call frames should be fetched when inspecting the back trace. Does not affect other attach process windows.

Break, Windows and Help Menus

See the chapter The Monitor Window [page 5].

1.1.7 The View Module Window

The view module window shows the contents of an interpreted module and makes it possible to set breakpoints.
The source code is indented and each line is prefixed with its line number. Clicking a line will highlight it and select it to be the target of the breakpoint functions available from the Break menu. Doubleclicking a line will set a line breakpoint on that line. Doubleclicking a line with an existing breakpoint will remove the breakpoint.

Breakpoints are marked with `-@-`.
Chapter 1: Debugger User's Guide

The Break Menu

The Break menu looks the same as the Break menu in the monitor window, see the chapter The Monitor Window [page 5], except that only breakpoints in the viewed module are shown.

File and Edit Menus

See the chapter The Attach Process Window [page 11].

Windows and Help Menus

See the chapter The Monitor Window [page 5].

1.1.8 Miscellaneous

Performance

Execution of interpreted code is naturally slower than for regularly compiled modules. Using the Debugger also increases the number of processes in the system, as for each debugged process another process (the meta process) is created.

It is also worth to keep in mind that programs with timers may behave differently when debugged. This is especially true when stopping the execution of a process, for example at a breakpoint. Timeouts can then occur in other processes that continue execution as normal.

Code loading mechanism

Code loading works almost as usual, except that interpreted modules are also stored in a database and debugged processes uses only this stored code. Re-interpreting an interpreted module will result in the new version being stored as well, but does not affect existing processes executing an older version of the code. This means that the code replacement mechanism of Erlang does not work for debugged processes.

1.1.9 Debugging Remote Nodes

By using debugger:start/1, it can be specified if Debugger should be started in local or global mode.

debugger:start(local | global)

If no argument is provided, Debugger is started in global mode.

In local mode, code is interpreted only at the current node. In global mode, code is interpreted at all known nodes. Processes at other nodes executing interpreted code will automatically be shown in the monitor window and can be attached to like any other debugged process.

It is not recommended to use Debugger in global mode on more than one node in a network, as they may interfere with each other leading to inconsistent behaviour.
Debugger Reference Manual

Short Summaries

- Erlang Module `debugger` [page 21] - Erlang Debugger
- Erlang Module `int` [page 28] - Interpreter Interface.

`debugger`

The following functions are exported:

- `start()` [page 21] Start Debugger.
- `start(File)` [page 21] Start Debugger.
- `start(Mode)` [page 21] Start Debugger.
- `start(Mode, File)` [page 21] Start Debugger.
- `quick(Module, Name, Args)` [page 21] Debug a process.

`int`

The following functions are exported:

- `im() -> pid()` [page 22] Start a graphical monitor
- `ii(AbsModule) -> {module, Module} | error` [page 22] Interpret a module
- `iq(Module) -> ok` [page 23] Do not interpret a module
- `ini(Module) -> {module,Module} | error | ok` [page 23] Do not interpret a module on all nodes in the network
- `inq(Module) -> ok` [page 23] Do not interpret a module on all nodes in the network
- `il() -> ok` [page 23] Make a printout of all interpreted modules
- `ip()` -> ok
  [page 23] Make a printout of the current status of all interpreted processes

- `ic()` -> ok
  [page 23] Delete (clear) information about all terminated processes from the interpreter.

- `iaa(Flag) -> true`
  [page 23] Automatically attaches to a process

- `iaa(Flag,Function) -> true`
  [page 23] Automatically attach to a process using Function as the attachment method.

- `ist(Flag) -> true`
  [page 24] Set the usage of call frame inspections

- `ia(Pid) -> ok | no_proc`
  [page 24] Attaches to a process

- `ia(X,Y,Z) -> ok | no_proc`
  [page 24] Attaches to a process

- `ia(Pid,Function) -> ok | no_proc`
  [page 24] Attaches to a process

- `ia(X,Y,Z,Function) -> ok | no_proc`
  [page 24] Attaches to a process

- `ib(Module,Line) -> ok | {error, What}`
  [page 25] Set a break point

- `ib(Module,Function,Arity) -> ok | {error, What}`
  [page 25] Set a break point in a function

- `ir(Module,Line) -> ok | {error, What}`
  [page 25] Delete a break point

- `ir() -> ok`
  [page 25] Delete all existing break points

- `ir(Module) -> ok`
  [page 25] Delete all break points in a module

- `ir(Module,Function,Arity) -> ok | {error, What}`
  [page 25] Delete a break point in a function

- `ibd(Module,Line) -> ok | {error, What}`
  [page 26] Disable a break point

- `ibe(Module,Line) -> ok | {error, What}`
  [page 26] Enable a break point

- `iba(Module,Line,Action) -> ok | {error, What}`
  [page 26] Set a break point trigger

- `ibc(Module,Line,Function) -> ok | {error, What}`
  [page 26] Set a conditional test at a break point

- `ipb() -> ok`
  [page 26] Make a printout of all existing break points

- `ipb(Module) -> ok`
  [page 27] Make a printout of all break points in module

- `iv() -> atom()`
  [page 27] Return the current version number of the interpreter

- `help() -> ok`
  [page 27] Print help text
The following functions are exported:

- `i(AbsModule) -> {module, Module} | error`
  [page 29] Interpret a module.
- `ni(AbsModule) -> {module, Module} | error`
  [page 29] Interpret a module.
- `n(AbsModule) -> ok`
  [page 29] Stop interpreting a module.
- `nn(AbsModule) -> ok`
  [page 29] Stop interpreting a module.
- `interpreted() -> [Module]`
  [page 29] Get all interpreted modules.
- `file(Module) -> File | {error, not_loaded}`
  [page 29] Get the file name for an interpreted module.
- `interpretable(AbsModule) -> true | {error, Reason}`
  [page 30] Check if a module is possible to interpret.
- `auto_attach() -> false | {Flags, Function}`
  [page 30] Get/set when and how to attach to a process.
- `auto_attach(false)`
  [page 30] Get/set when and how to attach to a process.
- `auto_attach(Flags, Function)`
  [page 30] Get/set when and how to attach to a process.
- `stack_trace() -> Flag`
- `stack_trace(Flag)`
- `break(Module, Line) -> ok | {error, break_exists}`
  [page 31] Create a breakpoint.
- `delete_break(Module, Line) -> ok`
  [page 31] Delete a breakpoint.
- `break_in(Module, Name, Arity) -> ok | {error, function_not_found}`
  [page 31] Create breakpoints in the specified function.
- `del_break_in(Module, Name, Arity) -> ok | {error, function_not_found}`
  [page 31] Delete breakpoints from the specified function.
- `no_break() -> ok`
  [page 31] Delete all breakpoints.
- `no_break(Module) -> ok`
  [page 31] Delete all breakpoints.
- `disable_break(Module, Line) -> ok`
  [page 31] Make a breakpoint inactive.
- `enable_break(Module, Line) -> ok`
- `action_at_break(Module, Line, Action) -> ok`
  [page 32] Set the trigger action of a breakpoint.
- `test_at_break(Module, Line, Function) -> ok` [page 32] Set the condition of a breakpoint.
- `get_binding(Var, Bindings) -> {value,Value} | unbound` [page 32] Retrieve a variable binding.
- `all_breaks() -> [Break]` [page 32] Get all breakpoints.
- `all_breaks(Module) -> [Break]` [page 32] Get all breakpoints.
- `snapshot() -> [Snapshot]` [page 33] Get information about all processes executing interpreted code.
- `clear() -> ok` [page 33] Clear information about processes executing interpreted code.
- `continue(Pid) -> ok | {error,not_interpreted}` [page 33] Resume process execution.
- `continue(X,Y,Z) -> ok | {error,not_interpreted}` [page 33] Resume process execution.
**debugger**

Erlang Module

Erlang Debugger for debugging and testing of Erlang programs.

Exports

```erlang
start()  
start(File)  
start(Mode)  
start(Mode, File)  
```

**Types:**
- `Mode = local | global`
- `File = string()`

Starts Debugger.

If given a file name as argument, Debugger will try to load its settings from this file. Refer to Debugger User’s Guide for more information about settings.

If given `local` as argument, Debugger will interpret code only at the current node. If given `global` as argument, Debugger will interpret code at all known nodes, this is the default.

```erlang
quick(Module, Name, Args)  
```

**Types:**
- `Module = Name = atom()`
- `Args = [term()]`

This function can be used to debug a single process. The module `Module` is interpreted and `apply(Module, Name, Args)` is called. This will open an Attach Process window, refer to Debugger User’s Guide for more information.
The module \texttt{int} provides short forms for some of the functions in the \texttt{int} module. This module also provides facilities for displaying status information about interpreted processes and break points.

It is possible to attach interpreted processes by giving the corresponding process identity only. By default, an attachment window pops up. Processes at other Erlang nodes can be attached manually or automatically.

By preference, these functions can be included in the module \texttt{shell.default}. By default, they are.

### Exports

\begin{verbatim}
im() -> pid()

Starts a new graphical monitor. This is the main window of the interpreter. All of the interpreter functionality is accessed from the monitor window. The monitor window displays the status of all processes that are running interpreted modules.

\end{verbatim}

\begin{verbatim}
ii(AbsModule) -> \text{[module, Module]} | error

Types:
- AbsModule = atom() | string() | [atom() | string()]
- Module = atom()

Marks Module as being interpreted. The Module parameter can either be a single module name, or a list of module names. Module is compiled into an abstract form which is loaded into the interpreter. The actual paths are searched for the corresponding source file(s) (\text{Module.erl}). Module can be given with an absolute path.

\end{verbatim}

**Note:**
If Module is a list of modules, the result of the last module is returned.

**Note:**
If an interpreted module is compiled using the \texttt{c:compile} function, this module is reloaded into the interpreter.
Debugger Reference Manual

**iq(Module)** -> ok

Types:
- `Module = atom() | string() | [atom() | string()]`

Does not interpret `Module`. The `Module` parameter can either be a single module name, or a list of module names. `Module` is removed from the set of modules currently being interpreted.

**ini(Module)** -> {module,Module} | error | ok

**inq(Module)** -> ok

Behaves as the corresponding `ii/1` and `iq/1` functions described above, but on all nodes in the network. It returns `ok` if we are alive, otherwise as above.

**il()** -> ok

Makes a printout of all interpreted modules. Modules are printed together with the full path name of the corresponding source code file.

**ip()** -> ok

Makes a printout of the current status of all interpreted processes. Processes on all known nodes are printed.

**ic()** -> ok

Deletes (clears) information about all terminated processes from the interpreter.

**iaa(Flag)** -> true

Types:
- `Flag = FlagItem | [FlagItem]
- FlagItem = init | break | exit | false`

Interpreted processes can be attached automatically, without the need to attach to a process using the monitor window, `i:im()` or `int:m()`. An attachment window - not described here - pops up for the attached process. `Flag` specifies at which point interpreted processes are automatically attached.

`Flag` is one of:
- `init`. Attach to a process the very first time it calls an interpreted function.
- `break`. Attach to a process whenever it reaches a break point.
- `exit`. Attach to a process when it terminates.
- `false`. Deactivate the automatic attach facility.

If several conditions are to be active, a list of flags must be given.

**iaa(Flag,Function)** -> true

Types:
- `Flag = FlagItem | [FlagItem]
- FlagItem = init | break | exit | false
- Function = {Mod,Func}
As above, but instead of using the default attachment window, the specified Function is used in order to start the interaction with the attached process. The Function parameter must be the tuple \( \{\text{Mod}, \text{Func}\} \), and this function should implement the corresponding functionality in the same way as the \texttt{int:show:a:start/3,4} functions.

\[
\text{ist}(	ext{Flag}) \rightarrow \text{true}
\]

Types:
- \text{Flag} = \text{all} \mid \text{true} \mid \text{no\_tail} \mid \text{false}

The interpreter can keep call frames in the stack for future inspections. Typically, you can go up and down in the stack in order to inspect the flow of control when the execution has been stopped - at a break point, when the process has terminated, or in a single step execution.

By default, the whole stack is kept (\text{Flag} = \text{all} or \text{true}). If processes with a very long life time and with a lot of tail recursive calls are interpreted, the \text{no\_tail} flag should be used. No tail recursive calls are kept in the stack if this flag is used.

The \text{false} flag should be used if the interpreter is not to keep call frames.

\[
\text{ia}(	ext{Pid}) \rightarrow \text{ok} \mid \text{no\_proc}
\]

Types:
- \text{Pid} = \text{pid()}

Attaches to the \text{Pid} process. An attachment window pops up.

\[
\text{ia}(	ext{X,Y,Z}) \rightarrow \text{ok} \mid \text{no\_proc}
\]

Types:
- \text{X} = \text{Y} = \text{Z} = \text{int()}

Attaches to the process with process identity \text{c:pid(X,Y,Z)}. An attachment window pops up.

\[
\text{ia}(	ext{Pid,Function}) \rightarrow \text{ok} \mid \text{no\_proc}
\]

Types:
- \text{Pid} = \text{pid()}
- \text{Function} = \{\text{Mod}, \text{Fun}\}
- \text{Mod} = \text{atom()}
- \text{Fun} = \text{atom()}

Attaches to the \text{Pid} process. Use \text{Function} for the interaction with the attached process, as for the \texttt{i:iaa/2} function.

\[
\text{ia}(	ext{X,Y,Z,Function}) \rightarrow \text{ok} \mid \text{no\_proc}
\]

Types:
- \text{X} = \text{Y} = \text{Z} = \text{int()}
- \text{Function} = \{\text{Mod}, \text{Fun}\}
- \text{Mod} = \text{atom()}

24

Debugger Application (DEBUGGER)
Attaches to the process with process identity %pid(X,Y,Z). Use Function for the interaction with the attached process, as for the i:iaa/2 function.

\textbf{ib(Module,Line) \rightarrow \{ok, What\}}

\textbf{Types:}
\begin{itemize}
  \item Module = atom()
  \item Line = int()
  \item What = badarg \mid break_exists
\end{itemize}

Creates a new break point at Line in Module. The execution of an interpreted process will be stopped before the expression at Line in Module is executed.

\textbf{ib(Module,Function,Arity) \rightarrow \{ok, What\}}

\textbf{Types:}
\begin{itemize}
  \item Module = atom()
  \item Function = atom()
  \item Arity = int()
  \item What = badarg \mid function_not_found
\end{itemize}

Creates break points at the first line in every clause of the Module:Function/Arity function.

\textbf{ir(Module,Line) \rightarrow \{ok, What\}}

\textbf{Types:}
\begin{itemize}
  \item Module = atom()
  \item Line = int()
  \item What = badarg \mid no_break_exists
\end{itemize}

Deletes the break point located at Line in Module.

\textbf{ir() \rightarrow \{ok\}}

Deletes all existing break points.

\textbf{ir(Module) \rightarrow \{ok\}}

\textbf{Types:}
\begin{itemize}
  \item Module = atom()
\end{itemize}

Deletes all existing break points in Module.

\textbf{ir(Module,Function,Arity) \rightarrow \{ok, What\}}

\textbf{Types:}
\begin{itemize}
  \item Module = atom()
  \item Function = atom()
  \item Arity = int()
  \item What = badarg \mid function_not_found
\end{itemize}
Deletes break points at the first line in every clause of the Module:Function/Arity function.

ibd(Module,Line) -> ok | {error, What}
Types:
- Module = atom()
- Line = int()
- What = badarg | no_break
Makes the break point at Line in Module inactive. The break point still exists, but no processes will be stopped at the break point.

ibe(Module,Line) -> ok | {error, What}
Types:
- Module = atom()
- Line = int()
- What = badarg | no_break
Makes the break point at Line in Module active. Processes will again be stopped at the break point.

iba(Module,Line,Action) -> ok | {error, What}
Types:
- Module = atom()
- Line = int()
- Action = enable | disable | delete
- What = badarg | no_break
Sets the status of the break point at Line in Module after it is triggered the next time. Action is: enable, disable, or delete.

ibc(Module,Line,Function) -> ok | {error, What}
Types:
- Module = atom()
- Line = int()
- Function = f Mod,Func g
- Mod = atom()
- Func = atom()
- What = badarg | no_break
Makes the break point at Line in Module conditional. Function is called whenever the break point is reached. Function is a tuple f Mod,Func g. Function must have arity 1 and return either true or false. This way, the break point either triggers, or not. The argument to Function is the current variable bindings of the process at the place of the break point. The bindings can be inspected using int:get_binding/2.

ipb() -> ok
Makes a printout of all existing break points.
ipb(Module) -> ok

Types:
• Module = atom()

Makes a printout of all existing break points located in Module.

iv() -> atom()

Returns the current version number of the interpreter.

help() -> ok

Prints help text.

Usage

Refer to the Debugger User's Guide for information about the graphical interface.

See Also

int(3), code(3)
The Erlang interpreter provides mechanisms for breakpoints and stepwise execution of code. It is mainly intended to be used by the Debugger, see Debugger User's Guide and debugger(3).

From the shell, it is possible to:

- Specify which modules should be interpreted.
- Specify breakpoints.
- Monitor the current status of all processes executing code in interpreted modules, also processes at other Erlang nodes.

By attaching to a process executing interpreted code, it is possible to examine variable bindings and order stepwise execution. This is done by sending and receiving information to/from the process via a third process, called the meta process. It is possible, but not recommended, to implement your own attached process. See int.erl for available functions and dbg_ui_trace.erl for possible messages.

**Breakpoints**

Breakpoints are specified on a line basis. When a process executing code in an interpreted module reaches a breakpoint, it will stop. This means that that a breakpoint must be set at an executable line, i.e. a line of code containing an executable expression.

A breakpoint have a status, a trigger action and may have a condition associated with it. The status is either active or inactive. An inactive breakpoint is ignored. When a breakpoint is reached, the trigger action specifies if the breakpoint should continue to be active (enable), if it should become inactive (disable), or if it should be removed (delete). A condition is a tuple \((\text{Module}, \text{Name})\). When the breakpoint is reached, \(\text{Module} : \text{Name}(\text{Bindings})\) is called. If this evaluates to true, execution will stop. If this evaluates to false, the breakpoint is ignored. Bindings contains the current variable bindings. Use \(\text{get_binding}\) to retrieve the value for a given variable.

By default, a breakpoint is active, has trigger action enable and has no condition associated with it. For more detailed information about breakpoints, refer to Debugger User's Guide.
Exports

\[
i(AbsModule) \rightarrow \{\text{module}, Module\} | \text{error}
\]

\[
ni(AbsModule) \rightarrow \{\text{module}, Module\} | \text{error}
\]

Types:
- AbsModule = Module | File | [Module | File]
- Module = atom()
- File = string()
- Options = term()

Interprets the specified module. \textit{i/1,2} interprets the module only at the current node. \textit{ni/1,2} interprets the module at all known nodes.

A module may be given by its module name (atom) or by its file name. If given by its module name, the object code \texttt{Module.beam} is searched for in the current path. The source code \texttt{Module.erl} is searched for first in the same directory as the object code, then in a \texttt{src} directory next to it.

If given by its file name, the file name may include a path and the \texttt{.erl} extension may be omitted. The object code \texttt{Module.beam} is searched for first in the same directory as the source code, then in an \texttt{ebin} directory next to it, and then in the current path.

\textbf{Note:}
The interpreter needs both the source code and the object code, and the object code must include debug information. That is, only modules compiled with the option \texttt{debug info} set can be interpreted.

\[
n(AbsModule) \rightarrow \text{ok}
\]

\[
nn(AbsModule) \rightarrow \text{ok}
\]

Types:
- AbsModule = Module | File | [Module | File]
- Module = atom()
- File = string()

Stops interpreting the specified module. \textit{n/1} stops interpreting the node only at the current node. \textit{nn/1} stops interpreting the module at all known nodes.

As for \textit{i/1} and \textit{ni/1}, a module may be given by either its module name or its file name.

\textbf{interpreted()} \rightarrow \text{[Module]}

Types:
- Module = atom()

Returns a list with all interpreted modules.

\textbf{file(Module)} \rightarrow \text{File} | \{\text{error, not}\_loaded\}

Types:
- Module = atom()
Debugger Reference Manual

- File = string()
  Returns the source code file name File for an interpreted module Module.

`interactable(AbsModule) -> true | {error,Reason}`

**Types:**
- AbsModule = Module | File
- Module = atom()
- File = string()
- Reason = no_src | no_beam | no_debug_info | badarg

Checks if a module is possible to interpret. The module can be given by its module name Module or its file name File.

The function returns true if both source code and object code for the module is found, and the module has been compiled with the option debug_info set.

The function returns {error,Reason} where Reason is no_src if no source code is found, no_beam if no object code is found, no_debug_info if the module has not been compiled with the option debug_info set, or badarg if AbsModule does not exist.

`auto_attach() -> false | {Flags,Function}`
`auto_attach(false)`
`auto_attach(Flags, Function)`

**Types:**
- Flags = [init | break | exit]
- Function = {Module,Name,Args}
- Module = Name = atom()
- Args = [term()]

Get and set when and how to automatically attach to a process executing code in interpreted modules. false means never attach, this is the default. Otherwise automatic attach is defined by a list of flags and a function. The following flags may be specified:

- **init** - attach when a process for the very first time calls an interpreted function.
- **break** - attach whenever a process reaches a breakpoint.
- **exit** - attach when a process terminates.

When the specified event occurs, the function Function will be called as:

`spawn(Module, Name, [Pid | Args])`

The resulting process can attach to, i.e. send commands to and receive messages from, the interpreted process, see above.

`stack_trace() -> Flag`
`stack_trace(Flag)`

**Types:**
- Flag = all | no_tail | false
Get and set how to save call frames in the stack. This makes it possible to inspect the call chain of a process.

- **all** - save all call frames. This is the default.
- **no_tail** - save all call frames, except for tail recursive calls. This option consumes less memory and may be necessary to use for processes with long lifetimes and many tail recursive calls.
- **false** - do not save call frames.

```
break(Module, Line) -> ok | {error,break_exists}
Types:
  • Module = atom()
  • Line = integer()
```

Creates a breakpoint at `Line` in `Module`.

```
delete_break(Module, Line) -> ok
Types:
  • Module = atom()
  • Line = integer()
```

Deletes the breakpoint located at `Line` in `Module`.

```
break_in(Module, Name, Arity) -> ok | {error,function_not_found}
Types:
  • Module = Name = atom()
  • Function = atom()
  • Arity = integer()
```

Create a breakpoint at the first line of every clause of the `Module:Function/Arity` function.

```
delete_break_in(Module, Name, Arity) -> ok | {error,function_not_found}
Types:
  • Module = Name = atom()
  • Arity = integer()
```

Delete the breakpoints at the first line of every clause of the `Module:Function/Arity` function.

```
no_break() -> ok
no_break(Module) -> ok
```

Deletes all breakpoints, or all breakpoints in `Module`.

```
disable_break(Module, Line) -> ok
Types:
  • Module = atom()
  • Line = integer()
```
Makes the breakpoint at Line in Module inactive.

-enable-break(Module, Line) -> ok

Types:
- Module = atom()
- Line = integer()

Makes the breakpoint at Line in Module active.

-action-at-break(Module, Line, Action) -> ok

Types:
- Module = atom()
- Line = integer()
- Action = enable | disable | delete

Set the trigger action of the breakpoint at Line in Module to Action.

-test-at-break(Module, Line, Function) -> ok

Types:
- Module = atom()
- Line = integer()
- Function = (Module,Name)
- Module = Name = atom()

Set the condition of the breakpoint at Line in Module to Function.

-get-binding(Var, Bindings) -> {value,Value} | unbound

Types:
- Var = atom()
- Bindings = term()
- Value = term()

Retrieve the binding of Variable. This function is intended to be used by a breakpoint condition function.

-all-breaks() -> [Break]

all-breaks(Module) -> [Break]

Types:
- Break = {Point,Options}
- Point = {Module,Line}
- Module = atom()
- Line = int()
- Options = [Status,Trigger,null,Cond]
- Status = active | inactive
- Trigger = enable | disable | delete
- Cond = null | Function
- Function = {Module,Name}
Debugger Reference Manual

- Name = atom()
  Gets all breakpoints, or all breakpoints in Module.

snapshot() -> [Snapshot]

Types:
- Snapshot = {Pid, Function, Status, Info}
- Pid = pid()
- Function = {Module, Name, Args}
- Module = Name = atom()
- Args = [term()]
- Status = idle | running | waiting | break | exit | no_conn
- Info = {} | {Module, Line} | ExitReason
- Line = integer()
- ExitReason = term()

Gets information about all processes executing interpreted code.

- Pid - process identifier.
- Function - first interpreted function called by the process.
- Status - current status of the process.
- Info - additional information.

Status is one of:
- idle - the process is no longer executing interpreted code. Info={}. 
- running - the process is running. Info={}. 
- waiting - the process is waiting at a receive. Info={}. 
- break - process execution has been stopped, normally at a breakpoint. Info={Module, Line}. 
- exit - the process has terminated. Info=ExitReason. 
- no_conn - the connection is down to the node where the process is running. Info={}. 

clear() -> ok

Clears information about processes executing interpreted code by removing all information about terminated processes.

continue(Pid) -> ok | {error, not_interpreted}
continue(X, Y, Z) -> ok | {error, not_interpreted}

Types:
- Pid = pid()
- X = Y = Z = integer()

Resume process execution for Pid, or for c:: pid(X, Y, Z).
# List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>The Line Break Dialog Window</td>
<td>3</td>
</tr>
<tr>
<td>1.2</td>
<td>The Conditional Break Dialog Window</td>
<td>4</td>
</tr>
<tr>
<td>1.3</td>
<td>The Function Break Dialog Window</td>
<td>5</td>
</tr>
<tr>
<td>1.4</td>
<td>The Monitor Window</td>
<td>6</td>
</tr>
<tr>
<td>1.5</td>
<td>The Interpret Dialog Window</td>
<td>10</td>
</tr>
<tr>
<td>1.6</td>
<td>The Attach Process Window</td>
<td>12</td>
</tr>
<tr>
<td>1.7</td>
<td>The View Module Window</td>
<td>15</td>
</tr>
</tbody>
</table>
Index of Modules and Functions

Modules are typed in this way.
Functions are typed in this way.

action_at_break/3
   int, 31

all_breaks/0
   int, 32

all_breaks/1
   int, 32

auto_attach/0
   int, 30

auto_attach/1
   int, 30

auto_attach/2
   int, 30

break/2
   int, 31

break_in/3
   int, 31

clear/0
   int, 33

continue/1
   int, 33

continue/3
   int, 33

debugger
   quick/3, 21
   start/0, 21
   start/1, 21
   start/2, 21

del_break_in/3
   int, 31

delete_break/2
   int, 31

disable_break/2

enable_break/2
   int, 32

file/1
   int, 29

get_binding/2
   int, 32

help/0
   i, 27

i

help/0, 27
   ia/1, 24
   ia/2, 24
   ia/3, 24
   ia/4, 24
   iaa/1, 23
   iaa/2, 23
   ib/2, 25
   ib/3, 25
   iba/3, 26
   ibc/3, 26
   ibd/2, 26
   ibe/2, 26
   ic/0, 23
   ii/1, 22
   il/0, 23
   im/0, 22
   ini/1, 23
   inq/1, 23
   ip/0, 23
   ipb/0, 26
   ipb/1, 27
   iq/1, 23
   ir/0, 25
   ir/1, 25
<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ir/2</td>
<td>25</td>
</tr>
<tr>
<td>ir/3</td>
<td>25</td>
</tr>
<tr>
<td>ist/1</td>
<td>24</td>
</tr>
<tr>
<td>iv/0</td>
<td>27</td>
</tr>
<tr>
<td>i/1</td>
<td></td>
</tr>
<tr>
<td>int</td>
<td>29</td>
</tr>
<tr>
<td>ia/1</td>
<td>24</td>
</tr>
<tr>
<td>ia/2</td>
<td>24</td>
</tr>
<tr>
<td>ia/3</td>
<td>24</td>
</tr>
<tr>
<td>ia/4</td>
<td>24</td>
</tr>
<tr>
<td>iaa/1</td>
<td>23</td>
</tr>
<tr>
<td>iaa/2</td>
<td>23</td>
</tr>
<tr>
<td>ib/2</td>
<td>25</td>
</tr>
<tr>
<td>ib/3</td>
<td>25</td>
</tr>
<tr>
<td>iba/3</td>
<td>26</td>
</tr>
<tr>
<td>ibc/3</td>
<td>26</td>
</tr>
<tr>
<td>ibd/2</td>
<td>26</td>
</tr>
<tr>
<td>ibe/2</td>
<td>26</td>
</tr>
<tr>
<td>ic/0</td>
<td>23</td>
</tr>
<tr>
<td>ii/1</td>
<td>22</td>
</tr>
<tr>
<td>il/0</td>
<td>23</td>
</tr>
<tr>
<td>im/0</td>
<td>23</td>
</tr>
<tr>
<td>ini/1</td>
<td>23</td>
</tr>
<tr>
<td>inq/1</td>
<td>23</td>
</tr>
<tr>
<td>int</td>
<td></td>
</tr>
<tr>
<td>action_at_break/3</td>
<td>32</td>
</tr>
<tr>
<td>all_breaks/0</td>
<td>32</td>
</tr>
<tr>
<td>all_breaks/1</td>
<td>32</td>
</tr>
<tr>
<td>auto_attach/0</td>
<td>30</td>
</tr>
<tr>
<td>auto_attach/1</td>
<td>30</td>
</tr>
<tr>
<td>auto_attach/2</td>
<td>30</td>
</tr>
<tr>
<td>break/2</td>
<td>31</td>
</tr>
<tr>
<td>break_in/3</td>
<td>31</td>
</tr>
<tr>
<td>clear/0</td>
<td>33</td>
</tr>
<tr>
<td>continue/1</td>
<td>33</td>
</tr>
<tr>
<td>continue/3</td>
<td>33</td>
</tr>
<tr>
<td>del_break_in/3</td>
<td>31</td>
</tr>
<tr>
<td>delete_break/2</td>
<td>31</td>
</tr>
<tr>
<td>disable_break/2</td>
<td>31</td>
</tr>
<tr>
<td>enable_break/2</td>
<td>32</td>
</tr>
<tr>
<td>file/1</td>
<td>29</td>
</tr>
<tr>
<td>get_binding/2</td>
<td>32</td>
</tr>
<tr>
<td>i/1</td>
<td>29</td>
</tr>
<tr>
<td>interpretable/1</td>
<td>30</td>
</tr>
<tr>
<td>interpreted/0</td>
<td>29</td>
</tr>
<tr>
<td>n/1</td>
<td>29</td>
</tr>
<tr>
<td>ni/1</td>
<td>29</td>
</tr>
<tr>
<td>nn/1</td>
<td>29</td>
</tr>
<tr>
<td>no_break/0</td>
<td>31</td>
</tr>
<tr>
<td>no_break/1</td>
<td>31</td>
</tr>
<tr>
<td>snapshot/0</td>
<td>33</td>
</tr>
<tr>
<td>stack_trace/0</td>
<td>30</td>
</tr>
<tr>
<td>stack_trace/1</td>
<td>30</td>
</tr>
<tr>
<td>test_at_break/3</td>
<td>32</td>
</tr>
<tr>
<td>interpretable/1</td>
<td>30</td>
</tr>
<tr>
<td>int</td>
<td>30</td>
</tr>
<tr>
<td>interpreted/0</td>
<td>29</td>
</tr>
<tr>
<td>ip/0</td>
<td>23</td>
</tr>
<tr>
<td>ipb/0</td>
<td>26</td>
</tr>
<tr>
<td>ipb/1</td>
<td>27</td>
</tr>
<tr>
<td>iq/1</td>
<td>23</td>
</tr>
<tr>
<td>ir/0</td>
<td>25</td>
</tr>
<tr>
<td>ir/1</td>
<td>25</td>
</tr>
<tr>
<td>ir/2</td>
<td>25</td>
</tr>
<tr>
<td>ir/3</td>
<td></td>
</tr>
</tbody>
</table>
Index of Modules and Functions

\[ i, 25 \]
\[ ist/1 \]
\[ i, 24 \]
\[ iv/0 \]
\[ i, 27 \]
\[ n/1 \]
\[ int, 29 \]
\[ ni/1 \]
\[ int, 29 \]
\[ nn/1 \]
\[ int, 29 \]
\[ no\_break/0 \]
\[ int, 31 \]
\[ no\_break/1 \]
\[ int, 31 \]
\[ quick/3 \]
\[ debugger, 21 \]
\[ snapshot/0 \]
\[ int, 33 \]
\[ stack\_trace/0 \]
\[ int, 30 \]
\[ stack\_trace/1 \]
\[ int, 30 \]
\[ start/0 \]
\[ debugger, 21 \]
\[ start/1 \]
\[ debugger, 21 \]
\[ start/2 \]
\[ debugger, 21 \]
\[ test\_at\_break/3 \]
\[ int, 32 \]